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CSE3142 Integrated Circuit Design

CMOS inverter and multiplexer — Analog simulation

Practical Experiment 1 Duration: two weeks

1.1 About this tutorial

In this tutorial we will study two Mentor Graphics tools: theDesign Architect for schematic entry,
andEldo for analog circuit simulation.
We will be using the ASIC Design Kit (ADK) which supplements Mentor Graphics tools with
libraries required for integrated circuit design. The Mentor Graphics tools will now be invoked with
the adk prefix and possibly with theic postfix.

In this tutorial we will investigate behaviour of theCMOS inverter and the“weak” multiplexer
which are the basic building blocks of the CMOSgate logicand theswitch logic, respectively.

1.1.1 Related documents

We will be directly or indirectly referring to the following documents:

• Designing ASICs with the ADK Design Kit and Mentor Graphics Toolsfrom
/sw/mentor/ADK/2.1/doc/pdf/adk.pdf.

• Design Architect-IC User’s ManualandDesign Architect-IC Reference Manualfrom
/sw/mentor/ICFlow/2004.1/shared/pdfdocs/daicuser.pdf,
/sw/mentor/ICFlow/2004.1/shared/pdfdocs/daicref.pdf

• AMPLE User’s ManualandAMPLE Reference Manualsfrom
/sw/mentor/ICFlow/2004.1/shared/pdfdocs/icampleuser.pdf,
/sw/mentor/ICFlow/2004.1/shared/pdfdocs/icampleref.pdf

• Eldo User’s Manualfrom /sw/mentor/ICFlow/2004.1/shared/pdfdocs/eldour.pdf

• CSE3142 Lecture Notesfrom http://www.csse.monash.edu.au/˜app/CSE3142

We would like also to acknowledgeUsing the ASIC Design Kit for Schematic Driven Layoutby
David M. Zar from Washington University in St. Louis available at:
http://ge.ee.wustl.edu/dzar/tutorials/adk_sdl/sdl_toc.html
Our practicals have been influenced by the material from the above tutorial.

1.2 Initial Setup

Check that the environment variable$HOME points to your home directory, then:

• In your .cshrc file replace all Mentor Graphics setup by:

source $HOME/mgc/mgcrc
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• Create directories$HOME/mgc and $HOME/mgc/ICdes

• Create a file $HOME/mgc/mgcrc with the following contents:

setenv ICDES $HOME/mgc/ICdes
setenv MGC_WD .

You will be using the UNIX environment variable$ICDES rather frequently. Another
often used environment variable is$ADK specified in the above scripts.

You can examine all the scripts if you are interested in other details of the setup.

• Check that your .login file does NOT set $path or $PATH .
If it does, move it to the .cshrc file.

• Create directory $ICDES/prac1

• Open a new terminal window in order to source.cshrc and change the directory to
$ICDES/prac1 . This will be your working directory.

1.3 Part1: CMOS Inverter

• From a directory $ICDES/prac1 invoke adk_daic &

• From the pull-down menu select

MGC > Location Map > Show Location Map

and verify that your Location Map is correct and that$MGC_WD(working directory) points
to your current directory.

• From the pull-down menu select

MGC > Location Map > Set Working Directory:

and verify that $ICDES/prac1 is really your working directory.

• Open a new schematic sheet by selecting from thesessionpalette Schematicentry.

In theOpen Schematic dialog box specify the new component, namely,Uinv whereU =
your initials, e.g., appinv.

The new schematic sheetUinv sheet1, will be opened.

• Maximise the window by typing inmax win. This is one of many ways of invoking AMPLE
commands.

Before we start creating a schematic a few comments about Ample scripts.
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1.3.1 Ample Scripts

If you look at the shell window from which you have invoked the Design Architect, you can note
that every operation in the Design Architect window is equivalent to an AMPLE script command.
You should see at least the following commands:

$$open_sheet("$HOME/mgc/ICdes/prac1/Uinv", "schematic",
"sheet1", @editable, void, "", @noupdate);

// max win
$maximize_window();

You can collect commands of interest in a script file, say,pr1.do, and then execute the script typing
in:

$dofile("pr1.do") or dof pr1.do
in order to re-do all your work if something goes wrong. You can also execute anindividual
commandby pasting it in the little window which appears when you type anything, say, SPACE.
Description of the AMPLE commands for a specific tool is also available through theHelp menu.

Events that occur during a session, including commented messages from the system, are recorded in
a transcript file as AMPLE functions. You can save all or part of the text in the transcript window to
a file by using the pull-down menu

MGC > Transcript > Show Transcript
and Notepad editing procedures. Because the logical transcript records events as AMPLE functions,
it creates a smaller and more easily edited file than a physical transcript does.

1.3.2 Help on Strokes and Function Keys

At this stage it is advisable for you to refresh you skill regarding Strokes and Function keys. Use an
appropriate help.

1.3.3 CMOS inverter — schematic entry

Now you will create a schematic of an inverter in one of the following graphical forms presented in
Figure 1. The form with a horizontal transistors is the preferred one because its topology more
closely resembles the topology of the resulting integrated circuit.
The main steps in creating a schematic are as follows:

• From the schematicedit palette selectLibrary .

• From the ic ibrary palette select and place appropriately on the schematic sheet one instance
of the followin components:

pmos, nmos(MOS FETransistors),cap (capacitor),GND, VDD (power terminals),In and
Out (I/O ports).

• Type in view all in order to see all details.

• To get back to theschematicedit palette, select theSchematic entry.

From the Edit section of theschematicedit palette you can execute required Move, Copy,
Delete, etc. operations.
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Figure 1: An inverter with a capacitive load in two graphical forms.

• In order to wire up the inverter, selectWire and create all connection required to build the
inverter.

• Rename theNET names on the ports toA and Y as shown in the schematic. You can do it
in a number of ways. On is to click onText to go to theschematictext palette and select
Change Value. Select the name and change its value.

Alternatively, you can use the Shift-F7 key.

• Next, change the value of thecapacitanceto 0.4pF (400fF). You can use previously described
methods, or, after selecting the capacitor, invoke the pop-up menu (RHB) from which you
select

Instance> Properties> Modify ...

• Similarly, change thewidth on the pMOS transistor to 10λ to make it wider. Leave other
dimensions unchanged.

• Now you canCheck & Save the schematic sheet with defaults. If any errors are reported, fix
them. Try to understand all warnings.

I used the AMPLE script similar to the following to create the inverter schematic. If you plan to use
my script fix the bugs existing in it.

// dof p1S.do
{ local x, y, y1, y2 ;

x = 2 ; y = 2 ; y1 = 1 ; y2 = 3.25 ;
$add_instance("$ADK/lib/sdl/nmos4","",[x,y], @perproperty, \

void,["width", "5"],@noflip,-90);
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$add_instance("$ADK/lib/sdl/pmos4","",[x,y+0.25], \
@perproperty,void,["width", "10"],@noflip,90);

$set_net_width(@p1);
$add_net([[x,y], [x,y+0.25]]);
x = x+0.5 ;
$add_net([[x,y1+0.25], [x,y2-0.25]]);

x = 1.5 ;
$add_instance("$ADK/lib/sdl/gnd","",[x,y1],@perproperty,void,[],@noflip,0);
$add_instance("$ADK/lib/sdl/vdd","",[x,y2],@perproperty,void,[],@noflip,0);
$add_net([[x,y2], [x,y2-0.25]]);
$add_net([[x,y2], [x+0.5,y2], [x+0.5,y2-0.25]]);
$add_net([[x,y1], [x,y1+0.25]]);
$add_net([[x,y1], [x+0.5,y1], [x+0.5,y1+0.25]]);

x = 0.75; y = 2.25 ;
$add_instance("$MGC_GENLIB/portin","", [x+1,y],@perproperty, \

void,[],@noflip,0);
$add_net([[x+1,y], [x+1.25,y]]);
$unselect_all();
$select_area([[x,y],[x,y]],@comment,void,@frame,@instance, \

@net,@pin,@property,@segment,@symbolpin,@text,@vertex);
$change_text_value("A");

x = 4 ;
$add_instance("$MGC_GENLIB/portout","",[x-1,y], \

@perproperty,void,[],@noflip,0);
$add_net([[x-1,y], [x-1.5,y]]);
$unselect_all();
$select_area([[x,y],[x,y]],@comment,void,@frame,@instance, \

@net,@pin,@property,@segment,@symbolpin,@text,@vertex);
$change_text_value("Y");
x = 2.75; y = 1 ;
$add_instance("$ADK/lib/sdl/cap","",[x,y], \

@perproperty,void,[],@noflip,0);
$unselect_all();
$select_area([[x+1,y+.85],[x+1,y+.85]],@comment,void,@frame, \

@instance,@net,@pin,@property,@segment,@symbolpin,@text,@vertex);
$change_text_value("400");
$add_net([[x,y], [x-0.75,y]]);
$add_net([[x,y+1], [x,y+1.25]]);
$view_all(); $unselect_all();

}

• Finally, when the schematic ischecked and savedyou canmake a symbolfor your inverter.
From the pull-down menu select

Miscellaneous> Generate Symbol

menu item to automatically generate a symbol. Do not change any of the options in the dialog
box and click on the OK button to generate your symbol.

• Your symbol will be a simple rectangle with two pins. You could modify the body of the

A.P.Paplínski, R. Prain 5



IC design, Prac 1 July 26, 2004

symbol to look like a typical inverter. We will only place the name of the inverter on the box
for future identification. To do this, you can use the

Edit > Add Graphics > Text

pull-down menu, or click onText to go to thesymbol text palette andAdd Comment
Text. Use the nameUinv. Place this text in the symbol. Modify the size and font if needed.

• Now you canCheck & Save the symbol. You can ignore the warnings about the properties
not being on the interface. If you have any other errors, however, you need to fix them before
moving on.

• Close the symbol window. You can use famous Mentor Graphics strokes!

1.3.4 Printing a schematic

Finally you might like to print the schematic for your report. To produce a post script file suitable for
encapsulation in your report, use the pull-down menu :

File > Print ...
Select theExport to File button and set up the path name for your schematic. I suggest to change
the path name to:$ICDES/prac1/UinvSch.eps .
Untick theColor Output box to avoid a yellow and light blue colour scheme.

Fixing a postscript file

Usually a postscript file generated by Mentor Graphics tools is too big and badly placed with respect
to its bounding box, hence, difficult to encapsulate in the text. In order to fix it edit a ‘*.eps’ file with
your favorite text editor.

• Search for ‘scale’ so you can find the following sequence of postscript statements:

0.240000 0.240000 scale
sm 1 slw
0.000000 300.000000 translate

• Modify them to read, say:

10 -90 translate
0.16 0.16 scale
sm 1 slw

• In addition fix the bounding box accordingly to read, say:

%%BoundingBox: 0 0 360 430

At this stage you can safely quit and re-enteradk daic (from the directory$ICDES/prac1 ) if
required.

A.P.Paplínski, R. Prain 6



IC design, Prac 1 July 26, 2004

1.4 Simulation – Selecting an IC technology

Up to now we have not specified any technology in which our integrated circuit will be
manufactured. Simulation results strongly depend on the selected technology.

From the schematicedit palette select
Simulation > TSMC0.35

This will specify the TSMC0.35 technology and create the followingviewpointswhich will be used
in the analog and digital simulation and in the circuit layout creation and verification.

tsmc035 for use with the digital QuickSim II Simulator
tsmc035a for use with the analog simulators
layout for use with IC Station when doing standard cell place and route
lvs for use with IC Station when performing LVS of your design
sdl for use with IC Station when doing SDL place and route

Examine the structure of theUinv directory to see that all the above viewpoints have been created.
Do not mess up in theUinv directory. Go back one level up to$ICDES/prac1 .

1.5 Analog Simulation with Eldo

We are ready to test our schematic. To do this we will perform analog simulation using Eldo.

Eldo is a SPICE-based analog simulator that can be invoked from theDesign Architect – IC. After
theEldo User’s Manualp.1-3 we reproduce in Figure 2 the following flowchart showing the basic
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Figure 2: Eldo simulation flowchart

input and output files. The main files are:
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*.cir The main Eldo control file, containing circuit netlist, stimulus and simulation control
commands. This file is SPICE compatible, the Eldo control language being a superset of the
Berkeley SPICE syntax. This file includes:

*.spi The circuit netlist SPICE file generated by the Eldo netlister,

*.sim The simulation commands and parameters prepared by the user.

*.chi The SPICE compatible output log file containing ASCII data, including results and error
messages.

*.cou A binary file containing Eldo analog simulation results data. A special interface is provided
giving you access to this data from your own post-processor software if required. ANACAD
post-processors also read and write to this file.

• Creating the netlist file.

From the schematicsim palette invoke Netlist > Write.

This will create a number of files with the circuit description in the directory
.../Uinv/tsmc035a . You can inspect the netlist file,Uinv tsmc035a.spi using the
Netlist > Edit command.

• Setting up the default viewer.

From the schematicsim palette select:

Setup > Session > Setup Simulator/Viewer...

and in the dialog window selectEZwave as the viewer.

• Preparing the simulation

Click on Analyses... from the schematicsim palette , this brings up a dialog window. Tick
Transient, then click theSetup... button. In the dialog window tick theInitial Conds box to
make Eldo calculate initial conditions before simulation. Ok both dialogs to continue.

• Selecting nets to view

Select bothA andY nets and invokeWave Outputs > Save Selected... andOK the
dialog boxes.

• Forcing input and power

Now we apply stimulus to the input net and provide power. SelectA and click onForces/ICs
> Add Forces... from the palette. ForceA to be a pulse from zero to five volts, with a duty
cycle of about half, and a period of 200ns.

Using the same buttons from the palette forceVdd to +5V DC, using the DC tab from theAdd
Forcedialog box.

The two forces should show up in red near the appropriate nets.
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• Including library file .

Up until now we have placed components and wired them together with nets. For simulation
Eldo requires models of the pmos4 and nmos4 transistor.

For this we include the tsmc035 spice library by invoking in theschematicsim palette
Lib/Temp/Inc > Libraries... command.

Enter$ADK/technology/accusim/tsmc035.modas the library path (The navigator can be
used to simplified the task) andNOM as the name of the library variant.

• Invoking Simulation .

From the schematicsim palette invoke Run ELDO.

This will pop-up two ASCII windows, the first is the results of running the netlister EldoNet,
and the second is the informative output of Eldo itself as it runs the simulation. On completion
press enter in each window to close them.

You can examine the resulting log file using theASCII Files > View Log command.

• Invoking a viewer

From the schematicsim palette invoke View Waves > New Window. By default EZwave
plotsA andY on top of each other, you can grab the text “V(Y)” from theTransient Restults
window and place it below the plot ofA. This should produce the plots as in Figure 3

Figure 3: Analog simulation waveforms for an inverter with the capacitance load.

• You can now exit the waveform viewer, end the simulation and quit the Design Architect.
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1.6 Part 2: XOR circuit based on a “weak” multiplexer

In Part 2 you will repeat steps from Part 1 for an XOR circuit based on a “weak” multiplexer. We
will study essential DC and transient properties of such a circuit.

1.6.1 A “weak” multiplexer

A “weak” multiplexer is a basic building block of the “switch logic”. The concept of the switch
logic is that logic circuits are implemented as combination of switches, rather than logic gates.
A 2-to-1 “weak” multiplexer has the following structure:

x0

x1

s y
y =

 x0 if s = 0
x1 if s = 1

When the signals is low, only thepMOS pass transistor is “on” andy = x0, and, conversely, when
the signals is high, only thenMOS pass transistor is “on” andy = x1.
Note that the “weak” multiplexer is similar to an inverter in that that it consists of an nMOS–pMOS
pair, with gates driven by the same signals. However the inverter’s VDD and GND connections have
been replaced with inputsx0, x1, which can be driven by logic signals.
The problem with the above circuit, which explains its name, is that when an input signal,x0 or x1,
is being passed to the output, the circuitdegrades:

• the low levelof thex0 signal passing through thepMOS transistor,

• thehigh levelof thex1 signal passing through thenMOS transistor,

You will study this effect in your simulation.

1.6.2 A “weak” XOR circuit

The Exclusive-OR (XOR) function:
f = a⊕ b

can be implemented using a2-to-1 multiplexer in the following way:

a b f

0 0 0
0 1 1
1 0 1
1 1 0

a f

0 b
1 b̄

f

a

b

b
0

1

A “weak” XOR can be built using a multiplexing pair of complementary MOS transistors and an
inverter (bn = b̄) as in Figure 4. In the table we indicate when a specific transistor is “on” and what
is the level of the output signal,f.
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f a

b p1

n1
bn

a b “on” f level

0 0 p1 b weak zero
0 1 p1 b strong one
1 0 n1 bn weak one
1 1 n1 bn strong zero

Figure 4: A “weak” XOR circuit

1.6.3 Schematic entry

Use the Design Architect to create a transistor-level schematic of the “weak” XOR presented in
Figure 4. Name the componentUxor . Arrange transistors horizontally, two pMOS transistors in
one line and two nMOS transistors below so that relevant gates face each other.
All transistors should have size of:L = 2λ, W = 5λ.

In addition create a schematic of a componentUxorC which has a capacitive load added to the
output f. A capacitor can be built using a gate-to-substrate capacitance as in Figure 5. Use an nMOS

GND

Figure 5: A gate-to-substrate capacitance

with dimensions:L = 2λ, W = 20λ.

1.6.4 Analog simulation

Simulate the “weak” XOR using the Eldo simulator for two caseswithout , andwith the capacitive
load. Prepare suitable forces and arrange all signals to obtain waveforms similar to those in Figure 6.
From your simulation waveforms estimate:

• The average propagation delay1, rise and fall times (10% to 90%) of the signalsbn and f
(zoom in around transitions).

• The voltage level of theweak zeroandweak one.

1Chapter 3 lecture notes
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f 

a

b

bn

Figure 6: Expected simulation waveform for the “weak” XOR with a capacitive load.

1.7 Demonstration and Report

• Demonstrate your working circuits to your tutor.

• Write a brief report in which you include a short description of your activities and the results
obtained. Include schematics and simulation results.

A.P.Paplínski, R. Prain 12



IC design, Prac 1 July 26, 2004

E
ld

o 
U

se
r’s

 M
an

ua
l, 

v5
.6

_1
5-

26

P
ul

se
 F

un
ct

io
n

S
ou

rc
es

   
A

ug
us

t 2
00

1

P
ul

se
 F

un
ct

io
n

P
U
L
S
E
 
(
V
0
 
V
1
 
[
T
D
 
[
T
R
 
[
T
F
 
[
P
W
 
[
P
E
R
]
]
]
]
]
)

G
en

er
at

es
 a

 p
er

io
di

c 
pu

ls
e 

as
 d

es
cr

ib
ed

 b
el

ow
. T

o 
be

 u
se

d 
in

 c
om

bi
na

tio
n 

w
ith

 
in

de
pe

nd
en

t v
ol

ta
ge

 (V
x
x

) o
r c

ur
re

nt
 (I
x
x

) s
ou

rc
es

.

P
ar

am
et

er
s

V
0

In
iti

al
 v

al
ue

 o
f D

C
 v

ol
ta

ge
 o

r c
ur

re
nt

.

V
1

Pu
ls

e 
m

ag
ni

tu
de

 in
 v

ol
ts

 o
r a

m
pe

re
s.

O
pt

io
na

l P
ar

am
et

er
s

T
D

D
el

ay
 ti

m
e 

in
 s

ec
on

ds
. D

ef
au

lt 
va

lu
e 

is
 z

er
o.

T
R

R
is

e 
tim

e 
in

 s
ec

on
ds

. D
ef

au
lt 

va
lu

e 
is
 
T
P
R
I
N
T

.

T
F

Fa
ll 

tim
e 

in
 s

ec
on

ds
. D

ef
au

lt 
va

lu
e 

is
 
T
P
R
I
N
T

.

P
W

Pu
ls

e 
w

id
th

 in
 s

ec
on

ds
. D

ef
au

lt 
va

lu
e 

is
 
T
S
T
O
P

.

P
E
R

Pu
ls

e 
pe

ri
od

 in
 s

ec
on

ds
. D

ef
au

lt 
va

lu
e 

is
 
T
S
T
O
P

.

Fi
gu

re
 5

-5
. P

ul
se

 F
un

ct
io

n

N
ot

e

If
 th

e 
pa

ra
m

et
er

s 
T
R
 

an
d 
T
F
 

ar
e 

bo
th

 s
et

 to
 0

, t
he

y 
ar

e 
as

si
gn

ed
 

a 
va

lu
e 

of
 
T
P
R
I
N
T,

 th
e 

m
in

im
um

 in
te

rn
al

 ti
m

e 
st

ep
 o

f t
he

 
si

m
ul

at
or

, d
ef

in
ed

 in
 th

e 
.
T
R
A
N
 

co
m

m
an

d.

T
D

Ti
m

e

V
ol

ts V
1

V
0

P
W

TR
TF

P
E

R

E
ld

o 
U

se
r’s

 M
an

ua
l, 

v5
.6

_1
5-

4

In
de

pe
nd

en
t V

ol
ta

ge
 S

ou
rc

e
S

ou
rc

es

   
A

ug
us

t 2
00

1

In
de

pe
nd

en
t V

ol
ta

ge
 S

ou
rc

e

In
de

pe
nd

en
t 

S
ou

rc
e 

E
le

m
en

t
V
x
x
 
N
P
 
N
N
 
[
[
D
C
]
 
D
C
V
A
L
]
 
[
A
C
 
[
A
C
M
A
G
 
[
A
C
P
H
A
S
E
]
]
]

+
 
[
T
I
M
E
_
D
E
P
E
N
D
E
N
T
_
F
U
N
C
T
I
O
N
1
]
 
[
R
P
O
R
T
=
v
a
l
 
[
N
O
N
O
I
S
E
]
]

+
 
[
T
C
1
=
v
a
l
]
 
[
T
C
2
=
v
a
l
]
 
[
I
P
O
R
T
=
v
a
l
]
 
[
C
P
O
R
T
=
v
a
l
]
 
[
L
P
O
R
T
=
v
a
l
]

+
 
[
N
O
I
S
E
T
E
M
P
=
v
a
l
]

N
oi

se
 S

ou
rc

e
V
x
x
 
N
P
 
N
N
 
[
[
D
C
]
 
D
C
V
A
L
]
 
[
A
C
 
[
A
C
M
A
G
 
[
A
C
P
H
A
S
E
]
]
]

+
 
[
R
P
O
R
T
=
v
a
l
 
[
N
O
N
O
I
S
E
]
]
 
[
T
C
1
=
v
a
l
]
 
[
T
C
2
=
v
a
l
]
 
[
I
P
O
R
T
=
v
a
l
]

+
 
[
C
P
O
R
T
=
v
a
l
]
 
[
L
P
O
R
T
=
v
a
l
]
 
[
N
O
I
S
E
T
E
M
P
=
v
a
l
]
 

+
 
N
O
I
S
E
 
[
T
H
N
=
V
A
L
]
 
[
F
L
N
=
V
A
L
]
 
[
A
L
P
H
A
=
V
A
L
]
 
[
F
C
=
V
A
L
]
 
[
N
=
V
A
L
]

+
 
[
F
M
I
N
=
V
A
L
]
 
[
F
M
A
X
=
V
A
L
]
 
[
N
B
F
=
V
A
L
]

Ta
bu

la
r 

N
oi

se
 S

ou
rc

e
V
x
x
 
N
P
 
N
N
 
[
[
D
C
]
 
D
C
V
A
L
]
 
[
A
C
 
[
A
C
M
A
G
 
[
A
C
P
H
A
S
E
]
]
]

+
 
[
R
P
O
R
T
=
v
a
l
 
[
N
O
N
O
I
S
E
]
]
 
[
T
C
1
=
v
a
l
]
 
[
T
C
2
=
v
a
l
]
 
[
I
P
O
R
T
=
v
a
l
]

+
 
[
C
P
O
R
T
=
v
a
l
]
 
[
L
P
O
R
T
=
v
a
l
]
 
[
N
O
I
S
E
T
E
M
P
=
v
a
l
]
 
N
O
I
S
E
 
T
A
B
L
E

+
 
[
[
I
N
T
E
R
P
=
v
a
l
]
 
[
D
E
C
|
O
C
T
|
L
I
N
|
L
O
G
]
]
 
(
f
1
 
v
a
l
1
)
 
(
f
2
 
v
a
l
2
)
 
.
.
.

M
ul

ti-
To

ne
 S

ou
rc

e
V
x
x
 
N
P
 
N
N
 
[
[
D
C
]
 
D
C
V
A
L
]
 
[
A
C
 
[
A
C
M
A
G
 
[
A
C
P
H
A
S
E
]
]
]

+
 
[
R
P
O
R
T
=
v
a
l
 
[
N
O
N
O
I
S
E
]
]
 
[
T
C
1
=
v
a
l
]
 
[
T
C
2
=
v
a
l
]
 
[
I
P
O
R
T
=
v
a
l
]

+
 
[
C
P
O
R
T
=
v
a
l
]
 
[
L
P
O
R
T
=
v
a
l
]
 
[
N
O
I
S
E
T
E
M
P
=
v
a
l
]

+
 
F
O
U
R
 
f
u
n
d
1
 
[
f
u
n
d
2
 
[
f
u
n
d
3
]
]
 
M
A
|
R
I
|
D
B
|
P
M
A
|
P
D
B
|
P
D
B
M
 

+
 
(
i
n
t
_
v
a
l
1
 
[
,
i
n
t
_
v
a
l
2
 
[
,
i
n
t
_
v
a
l
3
]
]
)
 
r
e
a
l
_
v
a
l
1
 
r
e
a
l
_
v
a
l
2

+
 
{
(
i
n
t
_
v
a
l
1
 
[
,
i
n
t
_
v
a
l
2
 
[
,
i
n
t
_
v
a
l
3
]
]
)
 
r
e
a
l
_
v
a
l
1
 
r
e
a
l
_
v
a
l
2
}

1.
 R

ef
er

 to
 th

e 
E
X
P

, P
A
T
T
E
R
N

, P
U
L
S
E

, P
W
L

, S
F
F
M

 a
nd

 S
I
N

 s
ou

rc
e 

fu
nc

tio
ns

.

N
P

N
N

V
xx
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